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Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

SOP . . . .
100 Configuration File Selection
PURPOSE
To select and copy the RDI VMDas configuration files.
Performed By
SOP TASKS

1. The VM-ADCP is controlled through RDI's VMDas software from PCLABO2. First make a new data directory under
‘c:0CEANO/RDT’, for example ‘c:OCEANO/RDI/ALBOREX_May_2014/’. This is where you will point the VmDAS
software to write your collected data files.

2. Locate your preferred historical water track and bottom track initialisation files (.ini files). The initialisation files
setup the processing parameters that you wish the VmDAS software to apply; for example
‘ALBOREX May2014_WT8m.ini’ and ‘ALBOREX May2014_BT8m.ini’ in directory ‘c:OCEANO/RDI/0S150Khz
Configuration files’. These example initialisation files are set to :-

Transducer depth =2 m

Blank beyond Transmit = 8 m (As determined in the acceptance trials)

Number of bins = 50

Bin Thickness =8 m

Lo-Res long range (narrowband) mode

Bottom tracking = on (Bottom tracking = off in ‘ALBOREX_May2014_WT8m.ini’ file)
Maximum bottom track distance = 400 m (N/A in ‘ALBOREX_May2014_WT8m.ini’ file)
Ping as fast as possible

EA Heading alignment set to -45.50

STA files = 120 second ensembles

LTA files = 600 second ensembles

amongst many other parameters.

3. Locate your preferred historical VM-ADCP command files (.txt files). These files contain the instructions sent to
the VM_ADCP electronics firmware, importantly they contain the depth independent water column salinity value
to be assumed during data collection. See, for example, ‘OS150BB&NBDEF_rleal 2BT.txt’ in
‘c:0CEANO/RDI/0S150Khz Configuration files’. It should be noted that setting water column salinity to 38.0 from
its default value of 35.0 only makes a very small difference to the apparent depth of the specified depth bins;
sound speed increases by only ~ 1 m s'! for every 1 psu in salinity. Furthermore, in the western Mediterranean
summer there is a strong near surface thermocline in which the temperature sensor of the VM-ADCP transducer
will record much higher temperatures than the majority of the water column, and again, sound speed increases by
~1mstforevery1°Cintemperature.

4. These files should be copied to file names relevant to the current campaign on which you are embarking and
saved in ‘c:OCEANO/RDI/0S150Khz Configuration files’. THE ORIGINALS SHOULD NOT BE ALTERED OR
DELETED.

5. There is no requirement for bottom track recording of data at every opportunity, but once a day or 2 or 3 times

during the cruise over long flat < 200 m continental shelves (in this region of the Mediterranean ~100 m is more
likely) would be desirable.

QUALITY ASSURANCE TASKS QA FORM

Task 1. Ensure the original configuration files are left unaltered.
Task 2. Ensure the copied configuration files are relevantly named and saved.
Task 3. Use bottom tracking in sensible water depths occasionally during the campaign
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Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

ngl:) Configuration file loading and modifying
PURPOSE
To modify the RDI VMDas configuration files.
Performed By
SOP TASKS
Start VmDas;
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Under the ‘Options’ menu select ‘Load’, choose the ****ini file that you copied under SOP1.1.1 (directory
‘c:OCEANO/RDI/0S150Khz Configuration files’). As discussed in SOP 1.1.1, this file contains most of the commands
in ascii text format sent to the VM-ADCP including the calibration heading offset angle and the amplitude scale
factor.

Under the ‘File’ menu you can select ‘Save As’ to create further copies of the ****.ini file

Under the ‘Options’ menu select ‘Edit Data Options’ (this opens the main ‘Program Options’ menu from which most
of the control parameters can be set)

Select menu item ‘Communications’. Check that the ADCP is set to COM3, and that NMEA1 and NMEA2 are set to
COM9 and COM10. It does not matter which way round COM9 and COM10 are as they both come from the Ashtech
ADU800 3D GPS system, it is simply important that NMEA1 and NMEA2 are not set to the same COM port, and
are set to COM 9 or COM 10.

Select menu ‘ADCP Setup’. Within this menu make sure that the ADCP Setup from ‘Use File’ option is checked, select
‘Browse’ and find for example the ****txt command file copied/created under SOP 1.1.1 (directory
‘c:OCEANO/RDI/0S150Khz Configuration files’). As discussed in SOP 1.1.1, this file contains an abbreviated set of
commands, importantly it contains the assumed salinity value that does not seem to appear in the .ini initialisation
files. The ****txt file can be modified in a text editor outside of VmDAS to set the water column salinity for example,
this cannot be set in VmDAS. An example file is as follows:-
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Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

SOP TASKS

; Restore factory default settings in the ADCP
crl

; set the data collection baud rate to 38400 bps,

; no parity, one stop bit, 8 data bits

; NOTE: VmDas sends baud rate change command after all other commands in
; this file, so that it is not made permanent by a CK command.

cb611

; Set for broadband single-ping profile mode (WP), fifty (WN) 4 meter bins (WS),
; 8 meter blanking distance (WF), 390 cm/s ambiguity vel (WV)

WP00001

WNO050

WS0400

WF0800

Wv390

; Set for narrowband single-ping profile mode (NP), sixty (NN) 4 meter bins (NS),
; 8 meter blanking distance (NF)

NNO060

NP00001

NS0400

NF0800

; Disable single-ping bottom track (BP),

; Set maximum bottom search depth to 400 meters (BX)
BP000O

BX04000

; output velocity, correlation, echo intensity, percent good
WD111100000

; 1 seconds between bottom and water pings
TP000100

; Two seconds between ensembles

; Since VmDas uses manual pinging, TE is ignored by the ADCP.

; You must set the time between ensemble in the VmDas Communication options
TE00000200

; Set to calculate speed-of-sound, no depth sensor, external synchro heading

; sensor, no pitch or roll being used, no salinity sensor, use internal transducer
; temperature sensor

EZ1020001

; Output beam data (rotations are done in software)
EX00000

; Set transducer misalignment (hundredths of degrees)
EA-04550

; Set transducer depth (decimeters)
ED00020

; Set Salinity (ppt)
ES38

; save this setup to non-volatile memory in the ADCP
CK

31 March 2014
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Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

SOP TASKS

7. The amplitude scale factor also cannot be modified through the VmDAS software. Again, a text editor needs to be
used, but this time to edit the ****.ini file. This is a much longer file, an example of the part of the ****ini file that
needs to be edited is show below:

[Transformation Options]

XformToEarth=TRUE

Allow3Beam=TRUE

BinMap=TRUE

BeamAngleSrc(0:auto,1:man)=0

ManualBeamAngle=30
HeadingSource(0:adcp,1:navHDT,2:navHDG,3:navPRDID,4:manual)=6
NMEAPortForHeadingSource=2

ManualHeading=0

TiltSource(0:adcp,1:nav,2:man)=4
NMEAPortForTiltSource=2

ManualPitch=0

ManualRoll=0
SensorConfigSrc(0:PRfixed,1:Pfixed,2:auto)=2
ConcavitySource(0:convex,1:concave,2:auto)=2
UpDownSource(0:dn,1:up,2:auto)=2
EnableHeadingCorrections=FALSE
SinCorrectionAmplitudeCoefficient=0
SinCorrectionPhaseCoefficient=0

MagneticOffsetEV=0

BackupMagneticOffsetEV=0

AlignmentOffsetEA=-45.5

EnableVelocityScaling=TRUE
VelocityScaleFactorForBTVelocities(unitless)=1.0110
VelocityScaleFactorForProfileAndWTVelocities(unitless)=1.0110
EnableTiltAlignmentErrorCorrection=TRUE
TiltAlignmentHeadingCorr(deg)=0
EAOptionSource=TRUE

TiltAlignmentPitchCorr(deg)=0
TiltAlignmentRollCorr(deg)=0

[2nd Band Transformation Options]
EnableVelocityScaling=TRUE
VelocityScaleFactorForProfileVelocities(unitless)=1.0110
[Backup HPR NMEA Source Options]
EnableBackupHeadingSource=FALSE
BackupHeadingSource(0:adcp,1:navHDT,2:navHDG,3:navPRDID,4:manual,5:PASHR,6:PASHR,ATT,7:PASHR,AT2)=0
NMEAPortForBackupHeadingSource=-1
BackupManualHeading=0
EnableBackupTiltSource=FALSE
BackupTiltSource(0:adcp,1:nav,2:man,3:PASHR,4:PASHR,ATT,5:PASHR,AT2)=0
NMEAPortForBackupTiltSource=-1
BackupManualPitch=0

BackupManualRoll=0

Note 1: It is necessary to enable velocity scaling (change FALSE to TRUE) as well as putting in the scale factor, it is also
necessary to repeat this under the ‘2rd Band Transformation Options’, these lines are highlighted in yellow above.

Note 2: In most applications the correct amplitude scaling factor will always be within a few percent of 1.0000.
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SOP TASKS
r 5
Program Options Lth
Communications ADCP Setup [ Recording I NAV I Transform ] Averaging I Data Screening [ User Exits I Sim Inputs I
ADCP Setup from Options
Water Curent Profile Heading Sensor
=
& v
Number of Bins: |50 g
(o)
Bin Size: 8 meters (Synchro/Stepper)
$Iank Distance: |2 meters Tit Sensor
ransducer 2
Depth: £ meters 7
(@
74 e
c Bottom Track
o 2 ol C

Maximum Range: |400 meters

ADCP Setup from File

[ @]
Command File
[C OCEANO\RDINOS 150 Khz Confic OREX_May2014 bt
Ensemble Time
(Ol
(@] Ensemble Time |0 seconds
LS - -]

ADCP Setup Tab
8. Select the command file and click ‘OK’ to return to the ADCP Setup, the path and command filename will be
displayed in the Command file window (setting the ‘Use File’ and providing the command file. When data collection
starts, the ****ini file will instruct the software to send all commands in this selected command file to the ADCP);

9.  Check the ‘ping as fast as possible’ option button on the same menu screen;

10. Select menu ‘Recording’ (this allows changing of the deployment name and the directory to which data is written,
very often this is the only menu that needs to be altered);

r 5
Program Options &J

Communications I ADCP Setup Recording I NAV I Transform | Averaging | Data Screening | User E)d‘!s] Sim Inputs I

Deployment Files

Name: ILLEC‘FE"Ja.W;

Number: 5 The deployment number displayed here is automatically chosen by
: the software each time data is collected or reprocessed. Change

Max Size (MB): [1— the number to ovenide the software’s choice.

Output Directories
r

Primary Path: IZ OC

(]

i

Backup Path: |: RDNADCP

Recording Tab Setup
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SOP TASKS

11.

12.

13.

14.

15.

16.

17.

18.

Type in a clearly relevant ‘Name’ for the cruise data files (up to 128 characters can be used), see SOP 6.0.0 task 2.
Select the first file number, e.g. 1, although see SOP 3.0.0 if this is not the beginning of survey;

‘Max Size (mB)’ refers to the raw data file size (A full 24 hours recording will require approximately 35 mB);
‘Dual Output Directories’ should only be used if 2 hard drives are in use;

‘Primary Path’, select the directory that will contain the ADCP data, which should already have been created (SOP
1.0.0);

Select menu ‘Averaging’. In this window the smoothing of individual raw velocity profiles to separate long and
short period average profiles is determined, this averaging is best achieved on time rather than distance;

r 5
Program Options lis-j

Communications | ADCP Setup | Recording | NAV ‘ Transform Averaging | Data Screening | User Exits l Sim lanRsl

Averaging Method

First Time Interval (STA): 120 seconds
Second Time Interval (LTA): 600 seconds

Profile Ping Nomalization Reference Layer
-

Start bin: |10
Endbin: |20

€

Set the ‘First Time Interval’ to 120 seconds;

Set the ‘Second Time Interval’ to 600 seconds;

NOTE: AS THE RAW DATA IS SAVED, AVERAGING CAN BE DONE AT ANY TIME INTERVAL DURING THE POST-

19.

20.

21.

22.

23.

PROCESSING STAGE.

Leave ‘Reference Layer Averaging’ as set;

Select menu ‘User Exits’ and check that ‘Launch WinADCP’ is not selected;

If a detailed real-time picture is required, select ‘Launch WinADCP’ and ensure the path to WinADCP.exe is
provided, WinADCP will open at the start of data collection and the ‘Data File To Open’ tells Win ADCP which type
of data to use and the ‘Refresh interval (sec)’ will tell WinADCP how often to check (note that if data collection is
stopped, WinADCP will remain open and when data collection is restarted another session will be run so make
sure Win ADCP is closed when data collection stops);

Ensure none of ‘Advanced User Only’ boxes are selected; Click ‘OK’ to accept your setup;

Select menu ‘NAV’. Navigation input should be set to read GPGGA from NMEA1.
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SOP TASKS

24.

25.

26.

27.

28.

29.

30.

31.

Select menu ‘Transform’. Heading input should be set to read PASHR,ATT from NMEA2
If required, Tilts input should also be set to read PASHR,ATT from NMEAZ2.

Under menu ‘Options’ select ‘Save As’ to save setup with your ****ini file name or a new initialisation file name if
required;

Return to menu ‘Options’ and select ‘Edit Data Options’ menu;
Select ‘ADCP Setup’ and change the command filename to your preferred command filename “****txt’;
Click ‘OK’;

Under menu ‘Options’ select ‘Save As’ to save this setup, provide a suitable filename for the new .INI file, click
‘Save’;

Save VmDas Settings To File (WVmDasAutoConfig.INI}: 7] x|
Save ju| 3 viDes = & & e
[Z] Dataak.ni

Save astbyps: | User Oolion Files [*.n) =l Cancel |

Repeat the above tasks for pairs of both water track and bottom track setup files.

QUALITY ASSURANCE TASKS QA FORM

Ensure that original .ini files are not overwritten and create back-up copies of the new
.ini files if required.

Ensure that original .txt files are not overwritten and create back-up copies of the new
.txt files if required.

Ensure that NMEA1 and NMEAZ2 navigation and heading data are being read from the
Ashtech ADU800 system on COM ports 9 and 10.
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SOP .
3.0.0 VM-ADCP data collection
PURPOSE
To start the VM-ADCP for a new survey operation.
Performed By
SOP TASKS

1. During data collection it is important that a log is kept of VM-ADCP operation. A standard log sheet has been
developed (Annex A ), both in electronic and paper format, that includes fields for all the necessary
information. A new log sheet should be filled in for each ‘start — stop’ period, of VM-ADCP operation. This
‘start — stop’ period refers to the period between clicking ‘Go’ and ‘Stop’ in the VmDas control menu (see tasks
12 and13). Parameters to be logged are:

Sequential log sheet number;

Date and cruise information;

Geographical region of operation;

.ini and .txt files in use;

Name and path supplied for data storage;

Time of ADCP start;

Filename on ADCP start;

Position (lat and long) on ADCP start;

Time of ADCP stop;

Filename on ADCP stop (normally the same as g, it will change automatically if files exceed the set
maximum file size);

k. Position (lat and long) on ADCP stop;

I.  Comments on conditions during data collection: e.g. type of survey, typical vessel speed, sea state,
weather, any notable oceanographic features (including time), any additional comments on ADCP
performance.

T TSe@me o0 T

2.  The electronic copies of these log sheets should be kept in the same directory as the ADCP data, and should
always accompany the ADCP data files; i.e. on transfer to Socib DCF. In addition, while all the ADCP setup
information is included in the stored .VMO data files, copies of the .ini and .txt command files should be placed
in the data directory prior to transmission to Socib DCF.

3.  Switch on the power to the ADCP (top left hand corner of the RDI Electronics Chassis) and to PCLABO2.

= ,—Sj
RO Instruments
@ G- © Anmt Gopper Bt Pty ||
v Coaen Srvayer
! s
cO
A ov
@ mn g E j
| — | —

Electronic Chassis Overview (Front View)

4.  Start Windows Explorer and create a directory into which the ADCP data is to be recorded (see SOP 1.0.0 task
1).

5. On completion of boot-up and log-on, a terminal program may be run if required, this allows a number of
system tests to be undertaken (SOP 5.0.0); running this program will provide some basic diagnostic
information if the ADCP fails to operate correctly here (SOP 4.0.0. task 1).
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SOP TASKS

6.

Start VmDas and under the ‘File’ menu select ‘Collect Data’.

File Controf rt Window Help
E | ad [T Bl l Dﬂ 7 NMEA C icat g
@ Profles ( ShipTrack1 ( Ship Track 2 4 afa r o
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System corfiguration £x/CC [Convex Ens Length [1418 bytes Bin 1 dit [15.57m Time /ping [00:00.00 NMEA 2 - SPASHR,ATT,120015.00,337.04437,-0.66957,
Sysfreq [153600 Hz Up/down [Down Bins [50 Blark dist [200m Pings/ens [1 NMEA 2 - §GPGGA,092000.00,3657.0960405,N,00047 .«
NMEA 2 - SPASHR,ATT,120016.00,336.49981,-0.6 4087,
Oper Mode [Natrow bndwdth B ange [30 deg Coord sys [Beam Binlength [8.00m Time/ens [00:00.00 NMEA 2 - SGPGGA,092001.00,3657.0978896,N,00047..
NMEA 2 - SPASHR,ATT,120017.00,335.63833,-0.74337,
pe=t Headg | 000£ 00 deg NMEA Heading data is now unavailable from its primai
Ens Num [6567 Date [26 May 2014 Pich [0002 000 deg  Temp [1395C  Xdor Depth 200m NMEA Tilt data is now unavailable from its primary sot
. NO NMEA Heading data will be stored in the NAY field
BITE Time [io Fol d Sainty [FEppt  SoundVel [152imis
oK e 16263057 A [000: 100018 deo S k)5 ot Soup Vel 152 s NO NMEA Tilt data will be stored in the NAY field starti
Botiom Track 5 NMEA Heading data can now be read from its primary
Velocly  %Good Conelson RSSIAmp Evaldmp  Range NMEA Tift date can nowr be read from [ts or
primary sourc
Speed |- PRIMARY NMEA Heading data will be stored in the NA'
Dirstion [~ E IE IE IE E 1E PRIMARY NMEA Tilt data will be stored in the NAV fielc
Botinge [ B e 1E e lE 1B -
mis % counts counts counts m
NB Raw Velocity - Ens 6667, 26 May 2014 10:24:30.97 NB Raw Data Quality - Ens 6667, 26 May 2014 10:24:30.97
Velocity (m's) Ref. Delta pos. Counts & Percent
-1.0 05 0.0 05 1.0 0 684 128 192 256
125 125
250 250
375
375
e E
epth (m) 0 25 50 7% 100
Beam!  ——— Beam2 | pepth(m)
—— Beam3 —— Beam4 RSSI Fitter Energy Percent good
NB... | Depth (.. | Bmi (m/s) [ Bm2 (m/s) | Bm3 (m/s) | Bmd (m/s) [RSSIL (c...| RSS2 (c...| RSSB (c.. | RSSH (c... | Energy... | Energy... [ Energy... [ Energy... [ Pct Gal (%) [ PctGd2 (%) [ Pt Gd3 (%) | Pet Ga4 (%) [ NB... [ -
1 79 138 1775 1929 1287 1 17 145 146 12 100 100 100 100 1 =
2 597 1319 1929 1553 1104 120 136 109 126 1 183 18 12 10 100 100 100 2
3 397 126 1919 1792 1202 17 151 14 136 193 1@ 191 193 100 100 100 100 3
4 a9 125 1891 1739 1073 105 115 116 106 19 189 11 188 100 100 100 100 4
5 09 12 1892 1906 1208 102 106 118 % 19 10 193 190 10 100 100 100 H
6 5797 1069 1889 1962 1248 104 103 8 10 1@ 12 18 12 10 100 100 100 6
7 6597 1391 1833 158 1215 101 104 7 8 1© 183 18 190 100 100 100 100 7
8 B9 117 1927 1472 1383 62 81 ) 8 16 192 190 193 100 100 100 100 3
Q R107 -1512 1018 1718 -107n 51 R7 7R 5Q 186 192 18Q 100 1nn 1nn 1nn 1nn Q Sl
|l Ens Good ” NAV Good

7. Under the ‘Options’ menu select ‘Load’. Choose the appropriate ****.ini file, created in SOP 2.0.0.

Under the ‘Options’ menu select ‘Edit Data Options’ to open the main ‘Programs Options’ menu then select
‘Recording’.

8.

-

Program Options

Communications ] ADCP Setup Recording l NAV I Transform ] Averaging ] Data Screening I User Exits ] Sim Inputs I

Deployment Files

Name: I ALBO

Max Size (MB): |100

Qutput Directories
-

The deployment number displayed here is automatically chosen by
the software each time data is collected or reprocessed. Change
the number to override the software’s choice.

Number:

Primary Path: ~ |C:\OCEANO'R

Backup Path: [ RDIMNAD
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9.  Type in the identifying name to be used for all data files in this survey, see SOP 1.0.0. Ensure the increment
number is 0 (if this is the restart of a survey or data recording then this should be set to the next sequential
number from the last set of files recorded).

10. In ‘Primary Path’ enter the name of the directory created in task 2 above. Then ‘OK’ to accept the setup.
11. Under the ‘Options’ menu select ‘Save As’ to save the setup. The new .ini file should be named in

accordance with the conventions in SOP 1.0.0, (do not type in the .ini extension, this will be added
automatically). Click ‘Save’.

Save VmDas Settings To File [VmDasAutoConfig.INI}): K1 E4
save | 3 ViDas = & & g
E] Dalauk.ni
Fil name: | Save
5 tp=: | Uzer Oplion Files [, - Cancel

ave o5 byps I er Oplion Files [*.ni) J |,;E

12. In ‘Control’ menu, click ‘Go’; data collection should now begin. Complete your ADCP event log with all the
required details. The ADCP communication and NMEA window will open and show the commands from the
command file being sent to the Ocean Surveyor and the Ocean Surveyor’s response, e.g..

: ADCP Communication
ADCP Setup: -~
—>0pening ADCP port... Successful

—>Waking up ADCP [up to 20 second timeout]...
Ocean Surveyor Broadband/Narrowband ADCP
RD Instruments [c] 1997-2000

All rights reserved.

Firmware Yersion: 14.14

>Detected ADCP type: Ocean Surveyor
—>Setting ADCP clock... TS 000607 082857
>Successful
VWakeup Successful
—>Initializing ADCP...

command file=C:\Program Files\RD Instrumentsi¥mDa:
—>5ending commands from ADCP command file...

|

ADCP Communication Window
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13. To stop data collection or cycle data files, go to the ‘Control’ menu and click ‘Stop’.

14. When it has been necessary to change to a different setup file, perhaps to change between water and bottom
track modes, or when it has been necessary to restart the data acquisition after a power failure, in these
cases the VmDas incremental file number will need to be manually set to the next number in sequence from

the last recorded files (see task 7).

15. When data from separate operations are recorded during the same survey, for example where a survey is
split by another type of data gathering exercise, the gathered periods of ADCP data may need to be clearly

identified. 2 options are available:
a. Each period can be stored in its own directory with an identifying name:

i. Atthe end of each period select 'Control’ and ‘Stop’;
ii. Follow SOP 1.0.0.

b. Use the VmDas software to increment the file number for each new period:

iii. Atthe end of each period select 'Control’ and ‘Stop’;

iv. The data will be saved to the same directory and same file name structure but the VmDas will

increment the number of the file.

QUALITY ASSURANCE TASKS

QA FORM

Ensure the correct ***.ini file is selected.

Ensure a sensible and relevant filename structure has been used.

Ensure the correct directory has been selected for writing the data files and

initialisation files.

4. Task 1. Ensure a sufficiently detailed log of events around the operation of the
ADCP is kept.

5. Task 2. Ensure events log is stored in the same directory as the ADCP data and

that the log sheet is rendered to Socib DCF.

L=
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SOP .
2,00 Problem Solving
PURPOSE
Data collection problems during ADCP operations.
Performed By
SOP TASKS

1. If the ADCP fails to respond to the initial start up, the following should be conducted:

a. Power down the ADCP and the pc, check all accessible leads (port connections into the back of the pc,
connections into the back of bridge units) are firmly in place. Restart the pc and check that power is being
supplied to the ADCP, then restart the ADCP;

b. If the ADCP still fails to start, close and restart VmDas. Select ‘File’ and ‘Collect Data’ then select
‘Options’ and ‘Load’ and load another or a default “.ini’ file, if the ADCP operates this indicates that there is
a fault in the preferred “.ini’ file; create another, see SOP 2.0.0 (if necessary also a command file, SOP
1.0.0), using the back up copies of both files;

c. Ifthe ADCP continues to fail, run a terminal program and acquire a log file of instrument tests (SOP 5.0.0),
and contact RDI with the results if necessary.

2. Heavy pitching can create larger currents than expected with bias velocities in line with the ship’s course.
Whilst the ADCP can in principle be set up to use the 3-d GPS input signal to correct for this (pitch and roll
input under the ‘Transform’ tab), the signal was historically considered too noisy, however the new Ashtech
ADUS8O00 system fitted to SOCIB appears to work well. Slow down to reduce pitching motion.

3. In areas of low zooplankton populations the ADCP may not get sufficient backscattered signals to make good
current measurements, this may vary with depth and so holes in the current profile or an apparently much
reduced range may be seen; attempt the following:

a. To overcome such gaps in the raw data files it will be necessary to decrease the number of depth cells
and increase their thickness, perhaps to as much as 16 m (SOP 1.0.0 and 2.0.0)

b. Profile gaps in the long term average (.Ilta) or short term average (.sta) files can sometimes be improved
simply by increasing the averaging time for these files (SOP 2.0.0);

4, Partial loss of a section of the velocity profile near the thermocline can be caused by high concentrations of
gelatinous organisms absorbing the acoustic energy. A further option to the above is to open ‘Data Screening’
in the ‘Program Options’ menu and change the ‘percent good’ value to 50%. This runs the risk of significantly
degrading the quality of the data, it should be a last resort and should be changed back again as soon as
environmental conditions allow.

QUALITY ASSURANCE TASKS QA FORM

1. Ensure a logical fault finding process has been followed.

31 March 2014 SOP 4.0.0




Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

SOP
0.0 VM-ADCP system tests
PURPOSE
To test the VM-ADCP instrument.
Performed By
SOP TASKS

NOTE: THIS TEST SHOULD BE CARRIED OUT PRIOR TO EACH VESSEL DEPLOYMENT AND AFTER EACH VESSEL
DEPLOYMENT.

1. The following RDI tests are used to confirm the connection of the Ocean Surveyor Electronics Chassis to the
transducer and the correct operation of the ADCP instrument mounted in the hull of the vessel.

2. Turn on the power to the OS ADCP Electronic Chassis unit.

— =T
o b et b
o Coan Srvayer
-
o0
ow
in 'nogg g
L L::[
— | S—

Electronic Chassis Overview (Front View)

3. Start a terminal programme, and connect to COM port 3, 9600 baud rate in ‘8 N 1’ bit format.

_loix

¢ File Edt View Transfer Tools Window Help =181 x|
o] o] 8] =]
S |

The following tests are basic tests which will confirm that your system
is ready for use. Some tests will need to be run with the system in
water. You will be prompted when this 1is necessary.

Turn on power to the O3 ADCP.
The results of all tests will be printed to the screen and saved to the

log file OS_TESTS.TXT. A file called O5_TESTS.TXT with the results of
this test will be created in the same directory as the BBTALK program ]

]
]
]
]
Connect the OS5 ADCP to power and the PC as described in the manual. ]
]
]
]
]

e )

is running from. ]
]
The following tests will be performed: ]
]
PTS RAM Verification Test ]
PTS ROM Verification Test ]
PT3 Interference Verification Test ]
PT6 Bandwidth Verification Test ]
15
Ready |comi:|115200, N, 8,1  [F2: Script OFF |F3: Log OFF [F4: ASCII 7

O0S ADCP BBTalk
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SOP TASKS

4. Press <F2> and run the script file TestOS.txt. The results of the tests will be printed to the screen and saved to the
log file OS_RSLTS.txt.

NOTE: PRINT AND SAVE A COPY OF THE OS_RSLTS.TXT FILE. USE THESE TEST RESULTS AS A “BASELINE” VALUE FOR
FUTURE COMPARISON OF THE PT TEST VALUES.

5. An example of the OS_RSLTS.txt printout is outlined below. If TestOS.txt does not exist, the individual tests can be
run by typing in the command at the beginning of each output shown below, i.e. PSO, PT3 and PT6 in the
command line window shown above. The following example results were recorded in December 2012.

NOTE: THE BUILT-IN TESTS REQUIRE THE TRANSDUCER FACES TO BE IMMERSED IN WATER. IF NOT SOME OF THE
TESTS MAY FAIL.

Display Systems Parameters
This tells the ADCP to display specific information about the ADCP. For example:

>PS0

Frequency: 153600 Hz
Configuration: 4 BEAM, JANUS
Transducer Type: Round 32x32
Beamformer Rev: AO02 or later
Beam Angle: 30 degrees
Beam Patten: Convex
Orientation: Down

CPU Firmware: 23.17

FPGA Version: AA

Sensors: Temp

Verify the information is consistent with that which is known about the setup of the system on the vessel. If PS0O does
not list all the sensors, there is a problem with either the communications to the transducer assembly of a problem
with the motherboard.

Interference Verification Test
This test checks receive-path characteristics, checks for interference signals in the processing circuitry, and checks
gain values. A message similar to the following should appear

NOTE:  COMPARE THESE TEST RESULTS WITH THE DOCKSIDE TESTS DONE WHEN THE SYSTEM WAS FIRST
INSTALLED, IF AVAILABLE.

>PT3

Correlation Magnitude:

Lag Bml Bm2 Bm3 Bm4
0 1.00 1.00 1.00 1.00
081 081 079 081
042 041 037 043
0.12 011 0.07 0.14
0.02 0.00 0.04 0.03
0.01 0.01 0.02 0.01
0.02 0.02 0.01 0.02
0.02 0.03 0.03 0.03

NO U WN

RSSI: 23 19 18 14
PASSED

Interference Test Pass/Fail Conditions - The ADCP pings without transmitting and displays the result of an
autocorrelation function performed over 8 lag periods. Ideally, high correlation at near-zero lags, and then
decorrelation as the lags get longer. High correlation values at longer lags indicate interference is present.

NOTE: PT3 TEST IS CONSIDERED TO HAVE PASSED IF THE CORRELATION VALUES AT LAG 5 AND GREATER ARE LESS
THAN 0.50.
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SOP TASKS

Bandwidth Verification Test
This test measures the receive bandwidth of the system.

NOTE: COMPARE THESE TEST RESULTS WITH THE DOCKSIDE TESTS DONE WHEN THE SYSTEM WAS FIRST
INSTALLED, IF AVAILABLE.

A message similar to the following should appear

>PT6
Receive Bandwidth:

Expected Bm1 Bm?2 Bm3 Bm4

15500 15174 15154 15167 15147

PASSED

NOTE: THE PT6 TEST IS CONSIDERED TO HAVE PASSED IF THE RECEIVED BANDWIDTH FOR EACH BEAM IS WITH
+20% OF THE EXPECTED BANDWIDTH.

Testing is now complete.

QUALITY ASSURANCE TASKS QA FORM
1. Run a terminal window connection to verify the VM-ADCP is functioning correctly
2. Keep a copy of the test results to build up a history of the instrument’s performance
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SOIE VmDAS file names

6.0.0

PURPOSE

To become familiar with file names for future playback, re-processing and visualisation.

Performed By

SOP TASKS

During data collection, VmDas outputs 10 data files, with different file extensions detailed below. The largest of
these files, the .ENR, .ENS and .ENX files will reach around 30-35 megaBytes (mB) each in size over a 24 hour
data recording period.

Data files produced by VmDas during data collect mode have the following filename format:
UserlnputCampaignNameNNN_0000ON.Ext; where:

UserlnputCampaignName is a user-entered name for the cruise files (up to 128 characters), see SOP 2.0.0, this
name should clearly identify the survey being carried out and be recognisable by the SOCIB DCF. The NNN is
the deployment number (this increments automatically by one with each ‘stop’/’go’ cycle), see SOP 3.0.0 for
notes regarding changes to deployment number and restarting data acquisition. The 00000N is the file
sequence number, which is automatically incremented when otherwise a file would be overwritten, normally the
sequence number would be 000000.

The file extensions, .Ext, have the following meaning:
i. .ENR - original raw ADCP data, an RDI binary file;

ii. .LTA - contains ADCP data and navigation data, averaged over the long term period (usually 10
minutes SOP 2.0.0), an RDI binary file;

ii. .STA — contains ADCP data and navigation data, averaged over the short term period (usually 2
minutes SOP 2.0.0), an RDI binary file;

iv. .ENS — ADCP data after having been screened for return signal amplitude (RSSI) and correlation by
VmDas. Also has navigation data records merged into the ensembles from the .NMS file (RDI
binary);

v. .ENX - ADCP single-ping data (plus navigation data) after having been vertically bin-mapped,
transformed to Earth coordinates, and screened for error velocity, vertical velocity, and false targets.
This data is ready for user averaging if the .STA and .LTA files are not preferred (RDI binary);
vi.  .N1R - contains raw navigation data (GPS position data), a text file;
vii.  .N2R - contains raw navigation data (roll/pitch/heading information), a text file;
(Note. The .N1R and .N2R extension files are simply the recorded NMEA strings for navigation and
roll/pitch/heading (RPH) data);
vii.  .NMS - Binary format navigation data file after having been screened and pre-averaged (RDI binary);

ix. .VMO - The option setting used for collecting the data (text file);

x. .LOG — ASCII file containing errors found in NMEA, ASCIlI Ensemble Output, or ADCP
communications.;

RDI binary files can be read, processed and converted to ASCII text files using WinADCP. The navigation
text files can be viewed using a standard text editor.

WARNING: NO ATTEMPT SHOULD BE MADE TO EDIT ANY OF THE ABOVE FIILES AND NO CHANGES BE
SHOULD BE MADE TO THE FILENAMES.
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QUALITY ASSURANCE TASKS QA FORM

1. Ensure a consistent and clearly identifiable flename nomenclature is used.
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SOP

7.0.0

Data processing and data display (VmDAS and WinADCP)

PURPOSE

To view VM-ADCP data previously collected or being collected in real time

Performed By

SOP TASKS

1.

To playback data in VmDAS:

a. Start VmDAS. Click File, Playback Data;

IJ EU fFfJJ Elﬁ EEEEe | EE

* Pofles ( ShipTrack1  ShipTrack2 el | b asjad arag ] B3 NMEA Communication X(
NMEA 2 - SGPHDT,337.04,7°06 A
System configuration Cx/CC [Convex Ens Length \ma bytes Bin1 dist [15.97m Time/ping [00:00.00 NMEA 2 - SPASHR,ATT,120015.00,337.04437,-0.66957,
- NMEA 2 - SGPGGA,092000.00,3657.0960405,N,00047.
Sysfreq [153600 Up/doun [D: Bins [50 Blank dit [3.00 Pings/ens [1
vetea : | ol | T S| NMEA 2 - SPASHRATT,120016.00,336.49981,-0.64087,
Oper Mode [Nanow bndwdth  Bm angle [30 deg Coord sys [Beam Binlength [8.00m Time/ens [00:00.00 NMEA 2 - SGPGGA,092001.00,3657.0978896,N,00047.:
NMEA 2 - SPASHR.ATT,120017.00,335.63833,-0.74337, |
b=tz Headng [ 0,00 00~ deg NMEA Heading data is now unavailable from its primar
Ens Num |6667 Date |26 May 2014 Pitch | 000+ 000 deg Temp [1996C  Xder Depth [2.00m NMEA Tilt data is now unavailable from its primary sot
NO NMEA Heading data will be stored in the NA field
BITEn [OK Time [10:24:30.97 Roll [000+ 000  deg Salinity [35 ppt Sound Vel [1521 m/s NO NMEA Tilt data will be stored in the NAY field startin |
Bottom Track NMEA Heading data can now be read from its primary
= eiocty /6 ood Mionsation IHIS S| SoRNEval ol “ﬂ"g‘i. NMEA Tilt data can now be read from its primary sourc
Speed |- - - PRIMARY NMEA Heading data will be stored in the NA'
Diection [ ﬁ /— ﬁ /7, . /— = PRIMARY NMEA Tilt data will be stored in the NAV fielc
Bot range [ [ 3
m/s % counts counts counts m
NB Raw Velocity; Ens 6667, 26 May 2014 102430 97 NB Raw Data Qualty - Ens 6667, 26 May 2014 10.24.30.97
Velocity (m's) Ref: Delta Counts & Percent
-1.0 -05 0.0 05 1.0 0 64 128 192

250 0.
et 0 2% 50 75 100
Beam 1 Beam2 | pepth (m
Beam3 Beam4 RSSI Fiter Energy Percent good
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3 4997 -1.292 1892 1906 -1.208 102 106 118 99 189 191 193 191 100 100 100 100 5
6 5197 1069 1889 1962 1248 104 103 80 110 12 192 1% 192 100 100 100 100 6
7 6597 1391 183 1586 1215 101 104 7 87 192 193 18 191 100 100 100 100 7
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[ Ens Good [ NAV Good

VmbDas Playback

b. Browse and locate the data file for the data you wish to view. Click Open;
c. NOTE. VmDAS will automatically search for *.ENR, *.ENX, *.STA, and *.LTA files (SOP 6.0.0);
d. On the Playback Tool Bar, click Play.

Data can be reprocessed in VmMDAS, by clicking on File, Reprocess Data. VmDAS then asks for the VMO
file for the original data processing controls (SOP 6.0.0). After selecting the .VMO file the user can then enter
a new .ini file or modify the commands in the command windows to reprocess the data; for example this may
be necessary to apply different calibration values (see SOP 2.0.0), or to apply additional heading, roll or pitch
offsets determined during post collection data analyses.

VmDAS generates ‘reprocessed’ data files, which have a similar flename structure with an additional 3
number group that increments each time reprocessing is conducted on the original file. VmDAS gives the
reprocessed control file the extension .VMP.

Data can be viewed in a more user friendly manner using WinADCP. To playback data in WinADCP

a. Start WinADCP;
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SOP TASKS

b. Click File, Open. Browse and locate the data file for the data you wish to view. Click Open. This will
load the *.ENR *.ENX, *.STA, or *.LTA file you wish to view;

c. Under Options choose the chart types and variables that you wish to view.

d. Real-time display of current data collection can be achieved, by opening one of the currently recording
VmDAS files. After choosing the viewing parameters that you wish to see in WinADCP, click on
Monitor, choose a sensible refresh period in seconds, e.g 120 seconds for .LTA files, click ON and the
display will update automatically as new data are collected and processed by VmDAS.

e. Historical files can also be played back in an animated mode by selecting Animate. Select from
Contour/Profile/Series and click Go. The time series of the ADCP data will now be animated (don’t quite
see how this is helpful though !).

f. A typical monitoring WinADCP playback screen is shown below.
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SOP

Calibrating the VM-ADCP orientation (amplitude scale factor and mis-alignment angle)

8.0.0

PURPOSE

To calibrate for the VM-ADCP mounting in the vessel hull

Performed By

SOP TASKS

1.  The VM-ADCP current profiles calculated and recorded in VmDAS are determined relative to earth
coordinates when the ADCP is linked to the correct operation of a 3-D GPS system, and is fully calibrated for
its mounting in the vessel hull.

2. In the following diagram, let us consider AUg and AV the velocity components of the bottom past the VM-
ADCP as measured by the VM-ADCP, and Ug and Vs the velocity components of the vessel from GPS
navigation data.

Now trigonometry tells us that.

Vs —tan(a _ ¢) _ sin(a —¢) _ sinacos¢ —cosasing
s - cos(a —¢) ~ cosacos ¢ +sinasing
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SOP TASKS

U Vv

8

but, coso =% and, sino =T;
Ug +‘/g VUg+Vg

V. V cos¢-U,sin
therefore, —- = —% 9 £ - ¢.
Us U,cosp+V, sing

If we cross multiply, divide through by COS¢, and re-arrange, we can show that the mis-alignment angle (]) is given by

ang = V.Us=UV
V.Vs+U,U;

Now we observe also that

Us =AU, cos¢p+ AV, sing,
and

Vi =AV, cosp - AU, sing,

V,(AU, cosg+ AV,sing) - U, (AV, cosg - AU, sing)

tan¢ = ;
VgVS + UgUS
which, after expanding, simplifying, dividing through by sin¢ and inverting both sides, gives the amplification
factor, A,
N (v,vs+U,U)
2 2 '
(Ug +V, )cos¢

3. These equations are already incorporated in example and historical excel calibration spreadsheets that can
be found in the /OCEANO/RDI/Example Calibrations Spreadsheets folder.

4, In WinADCP, open the bottom track file that you wish to use for a calibration. Select Export and choose
ancilliary data, Select a minimum of heading, east and north bottom track velocity components, bottom depth
and east and north navigation velocity components. Choose file type TXT and click on Write File.

5.  Open the file you have exported from WinADCP in Excel and paste the relevant velocity data into an example
excel calibration spreadsheet that can be found in the /OCEANO/RDI/Example Calibrations Spreadsheets
folder.

6. To improve the calibrations and reduce the statistical error standard deviation values, restrict your input
velocity pairs to those at reasonable constant vessel heading, vessel speed and bottom depth

31 March 2014 SOP 8.0.0




Vessel Mounted - Acoustic Doppler Current Profiler (VM-ADCP)

QUALITY ASSURANCE TASKS QA FORM
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- SOCIB VM-ADCP Log Sheet (May 2014)

B/O SOCIB
150 KHz RDI Ocean Surveyor VM-ADCP

Date: Voyage ID: Sheet no.
Geographical Region:
.ini file: .txt command file:

Deployment filename:

Primary Path:

Secondary Path (if dual disk data collection):

ADCP GO ADCP STOP
Time: Time:
Latitude: Latitude:
Longitude: Longitude:
First file: Last file (if different):

Additional In f Ormation (refer to earlier sheets if appropriate to avoid repetition)

Survey Type: Typical vessel course/speed:

Sea state: Wave height:

Other instrumentation?

Notes:
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